
Amazon Pay (EU and UK) - extension
for Magento 1.x

Release 3.0.20

Marek Stefan

Jun 10, 2021





Contents

1 Overview 3
1.1 Getting the extension . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
1.2 Extension features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
1.3 Extension vendor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

2 Prerequisites 5
2.1 System requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
2.2 Amazon Pay and Login with Amazon account setup . . . . . . . . . . . . . . . . . . . . . . . . . 5

3 Installation 17
3.1 Pre-installation steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
3.2 Installation process . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
3.3 Post-installation steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
3.4 Upgrade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

4 Configuration 25
4.1 Amazon Payments Account . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
4.2 General Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
4.3 Login with Amazon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
4.4 Email Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
4.5 Common Appearance Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
4.6 Alexa Delivery Notifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
4.7 Appearance Settings for Login and Pay with Amazon . . . . . . . . . . . . . . . . . . . . . . . . . . 33
4.8 Appearance Settings for standalone Pay with Amazon . . . . . . . . . . . . . . . . . . . . . . . . . 34
4.9 Developer options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

5 Design customization 35
5.1 Frontend templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
5.2 Amazon Payments logo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
5.3 Email templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

6 Login with Amazon 39
6.1 Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
6.2 Login with Amazon button . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

7 Order & payment workflow 43
7.1 Pay with Amazon button . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

i



7.2 Placing an order . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
7.3 Multicurrency support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
7.4 Payment authorization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
7.5 Capturing the payment amount . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
7.6 Refunding order items . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
7.7 Cancelling an order . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
7.8 Synchronizing order data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

8 Testing your integration 57
8.1 How to create Sandbox test account . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

9 Frequently Asked Questions 59
9.1 Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
9.2 Frontend . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

10 Troubleshooting 63
10.1 Event logs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
10.2 Contact support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

11 Changelog 65
11.1 Version 3.0.20 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
11.2 Version 3.0.18 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
11.3 Version 3.0.16 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
11.4 Version 3.0.14 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
11.5 Version 3.0.12 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
11.6 Version 3.0.10 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
11.7 Version 3.0.8 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
11.8 Version 3.0.6 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
11.9 Version 3.0.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
11.10 Version 2.0.28 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
11.11 Version 2.0.26 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
11.12 Version 2.0.24 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
11.13 Version 2.0.22 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
11.14 Version 2.0.20 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
11.15 Version 2.0.18 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
11.16 Version 2.0.16.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
11.17 Version 2.0.16 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
11.18 Version 2.0.14 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
11.19 Version 2.0.12 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
11.20 Version 2.0.10 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
11.21 Version 2.0.8 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
11.22 Version 2.0.6 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
11.23 Version 2.0.4 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
11.24 Version 2.0.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
11.25 Version 2.0.0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
11.26 Version 1.8.6 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
11.27 Version 1.8.4 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
11.28 Version 1.8.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
11.29 Version 1.7.8 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
11.30 Version 1.7.6 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
11.31 Version 1.7.4.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
11.32 Version 1.7.4 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
11.33 Version 1.7.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
11.34 Version 1.6.4 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
11.35 Version 1.6.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

ii



11.36 Version 1.6.0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
11.37 Version 1.3.4 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
11.38 Version 1.3.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
11.39 Version 1.2.6 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
11.40 Version 1.2.4 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
11.41 Version 1.2.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

iii



iv



Amazon Pay (EU and UK) - extension for Magento 1.x, Release 3.0.20

Proudly provided by:

creativestyle is a leading e-commerce agency with offices in Germany and Poland. For more information, please visit
https://www.creativestyle.de

Warning: This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) instead.

Warning: This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) instead.
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CHAPTER 1

Overview

This extension provides an official integration of your Magento store with Login and Pay with Amazon services.
They help your customers shop quickly, safely and securely. Your customers can pay on your website without re-
entering their payment and address details. All Amazon transactions are protected by Amazon’s A-to-z Guarantee.

The extension is a pure payment solution. No item level is communicated to Amazon Payments and it allows you to
manage your orders directly from Magento.

1.1 Getting the extension

This extension is not maintained anymore and isn’t available for the public download. Contact support in case you
need to obtain the installation package of this extension.

1.2 Extension features

• Pay with Amazon button in the shopping cart and in the 1st step of OnePage checkout

• Login with Amazon button on the customer login and registration page

• Customization of Login and Pay with Amazon widgets from within Magento admin

• Support for payment authorizations, captures and refunds (also partial refunds)

• Support for synchronous and asynchronous authorization

• Supports Amazon Instant Payment Notifications

• Live & sandbox modes available

• Toolbox for simulating payment states in sandbox mode

• CSV-based event logger

• Multilanguage, available languages: en, de, fr, es, it

3
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1.3 Extension vendor

This extension has been developed by creativestyle GmbH, a leading Magento agency, in cooperation with Amazon
Payments Europe S.C.A.

Creativestyle is an award-winning, pioneering e-commerce agency with more than 15 years of experience. Since
2001, they have been developing expertise in the field of technology and software solutions. With a 50 person team of
experts consisting of certified specialists in the fields of design, development and management of innovative projects,
they can guarantee a full range of services from consulting and planning, through concept and design, to technical
implementation and subsequent project support.

creativestyle GmbH
Erika-Mann-Straße 53
80636 München
Germany
https://www.creativestyle.de

Warning: This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) instead.

4 Chapter 1. Overview
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CHAPTER 2

Prerequisites

2.1 System requirements

Amazon Pay for Europe Magento extension requires you to have a valid Amazon Pay account (refer to the Amazon
Pay and Login with Amazon account setup if you don’t have one yet) and a webserver running a Magento store instance
with following conditions met:

• Magento CE (1.5, 1.6, 1.7, 1.8, 1.9) or EE (1.11, 1.12, 1.13, 1.14)

• cURL for PHP

• DOM / XML for PHP

• valid SSL certificate (for Login with Amazon and / or IPN handling)

Note: An additional fix needs to be installed for Magento 1.5. Please refer to the FAQ to get more details.

2.2 Amazon Pay and Login with Amazon account setup

2.2.1 Registering an Amazon Payments Account

• Go to:

– DE merchants: https://payments.amazon.de/preregistration/lpa

– UK merchants: https://payments.amazon.co.uk/preregistration/lpa

• Click Sign Up → I’m a merchant
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• Go through the questionnaire to find out if you qualify for using Amazon Payments, then click Sign up now

• At the moment you cannot add your Login and Pay with Amazon account to an existing Amazon merchant
account. You have to register a new account specifically for the Advanced Payments APIs.

• Start registering a new account:

– If you see the link Would you like to create a new account using a different e-mail address? Click here,
please do so.

– Enter a name for your business. In case this name is already taken, please choose a different one.

– Enter an email address and a password. You should choose a role email address that will be read directly
by the people responsible for the Amazon Payments integration. You should avoid general addresses like
info@ that are only forwarded to the general administration.

– Choose a secure password.

6 Chapter 2. Prerequisites
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• Please fill in all requested information about your seller account, your contact information and your bank account
or credit card data.

• Please be careful to provide exact and correct data. All information you provide will be verified by Amazon
Payments, and incorrect information will delay the verification process.

2.2. Amazon Pay and Login with Amazon account setup 7



Amazon Pay (EU and UK) - extension for Magento 1.x, Release 3.0.20

• After providing all information there will be an identity check on the phone, where you will be asked to enter a
PIN.

• Afterwards you can complete your registration
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• After your account is registered you will be forwarded to your Seller Central account.

• Please be aware that you cannot fully use your account yet. First you have to provide your identity data, and
then the account has to go through the verification process.

2.2.2 Entering identity data in Seller Central

To get the verification process started, please log in to Seller Central: https://sellercentral-europe.amazon.com/gp/
homepage.html

For a combined account (Login and Pay with Amazon added to an existing account), please make sure that you have
selected the Amazon Payments – Production View in the drop down menu on the top.

At Settings → Account Info please provide the requested missing information. Especially it is crucial to provide the
ID information for all relevant persons.

2.2. Amazon Pay and Login with Amazon account setup 9
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2.2.3 Verification Process / Verification of all given information by Amazon Pay-
ments

After successful registration of the Amazon Payments seller account and entering the ID information Amazon Pay-
ments will check all information provided. Depending on the information provided Amazon Payments may request
more information.

2.2.4 Creating MWS access keys

You can generate your MWS access keys in Seller Central. Please go to Integration → MWS Access Key

Log in again with your Amazon Payments account credentials
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Make sure that you register the MWS Access Key for your own account.

Please read and accept the license agreement.

2.2. Amazon Pay and Login with Amazon account setup 11
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The AWS Access Key and the Secret Key among with the Merchant ID, will be presented to you on the next page.
You can always review the key information in Seller Central on the Integration → MWS Access Key page.
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2.2.5 Registering application for Login with Amazon service

Login and Pay with Amazon work together to provide a great buyer experience. To use Login with Amazon you have
to register the application (Magento extension) that will be allowed to access buyers accounts through your Amazon
Payments seller account. Login with Amazon configuration settings can be accessed through Integration Central in
Seller Central.

On Integration Central page, scroll down to the ‘Manage client ID/store ID(s)’ sectionOn and register a new application
by clicking the ‘Create new client ID/store ID‘ button at bottom.

On the Create new client ID/store ID form, add basic details about your web site. These details will be used on your
website and mobile apps (if applicable). .. image:: /images/prerequisites_screenshot_21.png

2.2. Amazon Pay and Login with Amazon account setup 13
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• Application or store name. This is the name displayed on the consent screen when the users agree to share the
information with your web site. This name applies to website versions of your application.

• Description. A description of your web site for Login with Amazon users.

• Upload a logo. This logo will represent your business or website on Amazon. The logo will be displayed as a
150x150 pixel image; if you upload a file of a different size, it will be scaled to fit.

• Privacy policy URL. The Privacy URL is the location of your company privacy policy. It is also displayed
on the consent screen. This link is displayed to users when they first login to your application (for example:
http://www.example.com/privacy.html).

• Allowed JavaScript origins. The URL of your shop (for example: http://www.example.com). To add more than
one origin (in case you are running domain based multi-store Magento installation and all stores are using the
same Amazon Payments seller account), click Add another URL.

• Allowed return URLs. The Login with Amazon authorization service redirects users to this URL when they
complete login (for example: http://www.example.com/amazonpayments/advanced_login/redirect/ ).

On top of the creativestyle plugin configuration page you can find the URLs that need to be added to the Create new
client ID/store ID form mentioned before. .. image:: /images/prerequisites_screenshot_22.png

Note: To use Login with Amazon with your Magento shop, you MUST specify an allowed JavaScript origin.

2.2.6 Where to find the required credentials to configure the Magento extension

Magento extension requires you to enter information about your Amazon Payments account. You will need to enter:

• Merchant ID (aka Merchant Number, Händlernummer, Händler-ID)

Note: The Merchant Token IS NOT Merchant ID.

• AWS Access Key (aka AWS Access Key ID, AWS-Zugangsschlüssel, AWS Zugangsschlüssel-ID)

• Secret Key (aka AWS Secret Key, geheimer Schlüssel)

For Login with Amazon service you will also need:

• Client ID

You can find this information in your Amazon Payments seller account in Seller Central.

14 Chapter 2. Prerequisites
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2.2.7 Configuration required in Seller Central

If you’re planning to use IPN for the post-payment processing you need to enter a Merchant URL (IPN endpoint URL)
in Seller Central. You can do this at Settings → Integration Settings, then click the Edit button at Instant Notification
Settings. IPN endpoint URL can be obtained from Magento admin at System → Configuration → Amazon Payments,
see: IPN endpoint URL.

Warning: This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) instead.

2.2. Amazon Pay and Login with Amazon account setup 15
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CHAPTER 3

Installation

3.1 Pre-installation steps

• Create a backup of your shop before proceeding to install.

• If your shop is using compilation (you can check it in System → Tools → Compilation), disable it please before
proceeding to install.

3.2 Installation process

3.2.1 Installation via Magento Connect Manager

• Go to System → Magento Connect → Magento Connect Manager and enter your admin credentials to get logged
in.

17
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• In the Install New Extensions section enter the extension key and click Install button. Magento Connect Manager
will validate the key and check the extension dependencies and will display a pre-installation summary. Click
Proceed button to start the installation.
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• After the successful installation, please click on Refresh button to refresh the list of the installed extensions and
assure that Login and Pay with Amazon (identified as Creativestyle_AmazonPayments) is listed on that list.

• Proceed to the Post-installation steps.

3.2.2 Manual installation

• Contact support to obtain a copy of the installation package of this extension. Unpack the received file to your
Magento root directory.

3.2. Installation process 19
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Note: If you are using any VCS (git, svn, mercurial) for versioning your shop basecode, you can also commit the
content of the received file to the VCS repository and next deploy it to your shop.

• Proceed to the Post-installation steps.

3.3 Post-installation steps

• If you’re using custom design theme, refer to the Templates customization section to find out how to adjust
Login and Pay with Amazon templates to your needs.

• Go to System → Cache Management and flush Magento cache storage.

• If you have disabled compiler in pre-installation stage, you can go now to System → Tools → Compilation,
recompile and enable compiler again.

• Logout from the Magento admin and login again.

Voila! The Login and Pay with Amazon extension shall be installed now. You can proceed to the Configuration
followed by Frontend templates and Email templates customization (if applicable).

3.4 Upgrade

3.4.1 Pre-upgrade steps

1. Create a backup of your shop before proceeding to upgrade.

2. If your shop utilises compilation (you can check it in System → Tools → Compilation), disable it please before
proceeding to upgrade.

3.4.2 Migrating from Magento Connect / Marketplace

• Go to System → Magento Connect → Magento Connect Manager and enter your admin credentials to get logged
in.
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• On the list of the installed extensions please find Creativestyle_AmazonPayments, select Uninstall in the corre-
sponding action dropdown list and click Commit changes button.

• After the successful uninstallation from the previous source, install it as described in the Installation via Magento
Connect Manager section.
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3.4.3 Upgrade process

• Go to System → Magento Connect → Magento Connect Manager and enter your admin credentials to get logged
in.

• Click Check for Upgrades button in the Manage Existing Extensions section. If the newest version of Amazon
Pay is available, the Creativestyle_AmazonPayments extension on the list will be highlighted with the yellow
color. In the corresponding action dropdown list please select Upgrade to X.X.X (stable) option and click Commit
changes button.

• After the successful upgrade, please click on Refresh button to refresh the list of the installed extensions and
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assure that Login and Pay with Amazon (identified as Creativestyle_AmazonPayments) was upgraded to the
desired version.

• Proceed to the Post-upgrade steps section.

3.4.4 Post-upgrade steps

Version 3.0.2 comes with a significant change to the payment processing workflow (comparing to versions 1.x and
2.x). Prior to version 3.x the payment authorization was requested during placing the order (i.e. right after clicking
Save order button in the checkout), thus in synchronous and optimized authorization mode (assuming there wasn’t
transaction timed out error), the order ended up with the immediate authorization result.

Since the Strong Customer Authentication (derived from the PSD2 directive) was introduced in version 3.0.2, the
authorization is requested after the order is actually placed. Thus, it may happen that the order payment remains
unauthorized for a longer time unless the buyer finishes his Multi-Factor Authentication challenge. This change has to
be considered for passing the order to the fulfillment process, to avoid fulfilling the orders that haven’t been actually
paid. As stated in Payment authorization section, it is always advised to start fulfilling the order after the authorization
is confirmed, which, in the default configuration, is reflected by the “Processing” order status.

3.4.5 Upgrade to 3.x troubleshooting

After upgrade to 3.x, when the buyer clicks Amazon Pay button in the cart, he is redirected to the customer
dashboard instead of the checkout.

1. Please make sure that your webserver serves the most recent version of the
js/creativestyle/amazonpayments.min.js file. Some webservers (as well as CDNs) are caching static as-
sets, so it may happen that your shop serves an outdated version of the frontend JS application.

2. If you are using custom layout or template files for Amazon Pay, make sure that your customizations are com-
pliant with the recent changes in the extension. The easiest way to check is your customization is the case is to
delete following files as after refreshing Magento cache, see if this resolves your issue:

• app/design/frontend/CUSTOMPACKAGE/CUSTOMTHEME/layout/amazonpayments.xml

• app/design/frontend/CUSTOMPACKAGE/CUSTOMTHEME/template/creativestyle/amazonpayments/js.phtml

• app/design/frontend/CUSTOMPACKAGE/CUSTOMTHEME/template/creativestyle/amazonpayments/login/redirect.phtml

Warning: This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) instead.
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CHAPTER 4

Configuration

After the successful installation you can proceed to the configuration. In Magento admin go to creativestyle → Amazon
Pay and Login with Amazon → Settings (or System → Configuration → Amazon Payments tab).

Available options are grouped in following sections:
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4.1 Amazon Payments Account

In this section you can define your Amazon Payments seller account credentials.

4.1.1 Merchant ID, Access Key ID, Secret Access Key

Fill out those fields with your Amazon Payments seller credentials. You can find them in the Amazon Seller Central,
see: Where to find the required credentials to configure the Magento extension.

4.1.2 Marketplace

Select the country where you registered your seller account from the provided drop-down list. If you’re unsure about
this information consult your Amazon Integration Assistant.

4.1.3 Validate Amazon Payments account

This button is designed to validate your Amazon Payments account credentials. Please use it to check whether your
credentials (Merchant ID, Access Key ID, Secret Access Key and Marketplace) are valid or not.

Warning: Please note that the above feature will validate ANY Amazon MWS account, also such one that is not
registered to Amazon Payments.

4.2 General Settings

In this section you can enable or disable the Pay with Amazon service and define basic settings of the extension.
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4.2.1 Enable Pay with Amazon

By switching this option you can enable or disable Pay with Amazon. This option must be set to Yes if you want to
provide the Pay with Amazon service to your customers.

4.2.2 Sandbox mode

Sandbox mode has been designed to test the Pay with Amazon service. In sandbox mode the selected payment
method is not charged. Refer to the Pay with Amazon documentation to get more information about the sandbox
environment. In general, sandbox mode should be enabled for development and staging environments for testing and
always has to be disabled for production environments. Never show the sandbox buttons and widgets to buyers in your
live environment.

4.2.3 Show Sandbox Toolbox

In sandbox mode you can simulate certain states for the different objects in the payment process. By enabling this op-
tion you get additional fields on the Amazon Checkout page that allow selecting expected payment statuses for orders,
authorizations, captures and refunds returned in responses. This feature allows you to simulate different scenarios
including declines in the sandbox environment.

4.2.4 Payment Action

You can select the desired payment action taken after an order is placed. Available options are:

• Manual authorization - the order reference is created only. Authorization must be requested manually by click-
ing Authorize button on the order preview page in Magento admin.

• Authorize (default) - order reference creation is followed by automatic authorization request. Capture must be
requested manually by creating an invoice with Capture online option selected.

• Authorize & capture - order reference creation is followed by automatic authorization and capture request.
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• ERP mode - same as Manual authorization, but further payment processing (authorization, capture, IPN notifi-
cations handling) is blocked in Magento. In this mode, it is assumed that after order reference creation rest of
the payment processing steps will be handled by merchant’s external ERP system.

Warning: Please do not use ERP mode unless your ERP system supports Amazon Payments transactions pro-
cessing.

4.2.5 Authorization Processing Mode

This option defines mode of calling authorization request. By default Asynchronous mode is set, meaning that the
Amazon Payments API responses immediately, but the authorization status is not known exactly and thus returned as
Pending. This behavior requires authorization status update (either via IPN notification or cron-triggered data polling)
before dispatching the order. Synchronous authorization returns its status immediately, but such a process takes usually
few seconds more than Asynchronous authorization, causing your customer needs to wait longer until success page
appears after Place order button click.

4.2.6 Enable Instant Payment Notifications

This option enables or disables handling of Instant Payment Notifications, which are used by Amazon Payments for
sending feedback concerning the status of payment objects. Keep in mind that using IPN requires valid SSL certificate
(issued by a trusted CA) installed on your server and correctly configured Secure Base URL and Use Secure URLs in
Frontend config options (System → Configuration → Web → Secure section). In case you disable IPN and want to use
data polling instead you need to setup a cron for your shop.

Note: Trusted Certificate Authorities and other SSL requirements are listed on Amazon Payments webpage in english
and german language.

4.2.7 IPN endpoint URL

This auto-generated value shall be entered in the Merchant URL field of the Integration Settings in your Amazon
Seller Central in case you plan to use IPN. If you use more than one store view in your Magento installation, the IPN
endpoint URL will be shown after selecting appropriate store view scope.

4.2.8 Data polling frequency

If you don’t have a valid SSL certificate in your shop or due to any other reason you don’t want to use IPN, you can
set how often status of the different object shall be polled from Amazon Payments servers. Note that the cron must be
setup for your shop for periodic triggering routines that poll payment data.

4.2.9 New order status

With this option you can choose the status for newly created orders. Statuses assigned to New state are allowed only.
Please note that this config option becomes obsolete when you use synchronous authorization, initial order status will
be set to Order status on authorization value then.

4.2. General Settings 29

https://payments.amazon.co.uk/help/81779
https://payments.amazon.de/help/81779


Amazon Pay (EU and UK) - extension for Magento 1.x, Release 3.0.20

4.2.10 Order status on authorization

With this option you can change the status that will be set for an order after a successful authorization. Statuses
assigned to Processing state are allowed only. In most cases leaving the default value seems to be a good idea.

Warning: Please note the difference between state and status terms in Magento. State is used by Magento
internally to identify current stage of the order workflow, while status is some kind of a descriptive reflection of the
state for seller purposes. Just as it is not possbile to define custom states in Magento, it is not possible to configure
the extension to use different order states as well (New aka Pending is used for newly created orders, Processing
- for successfully authorized orders). This rule implies that New order status can be only changed to the status
that is assigned to New state, while Order status on authorization to the status assigned to Processing state. Any
attempt to modify this behavior in the extension source code directly may lead to the inconsistency of the order
workflow and may cause hard to debug issues. In case you need different than New state for the newly created
order, consider using synchronous authorization which gets authorization status immediately and uses Order status
on authorization straight away.

4.3 Login with Amazon

In this section you can configure Login with Amazon service.

4.3.1 Enable Login with Amazon

By switching this option you can enable or disable Login with Amazon feature. This service must be enabled if you
want to create customer accounts in your Magento shop when order is placed and to make sure that any of the orders
paid with Pay with Amazon will be never a guest order.

4.3.2 Client ID

The Client ID identifies your website for Login with Amazon service. Please refer to Where to find the required
credentials to configure the Magento extension section to find out how to get the value of your Client ID.

4.3.3 Display Language

In this option you can select a language which will be used for displaying all elements (froms, widgets) generated by
Amazon Payments. Selected language will be also used to localize emails sent by Amazon Payments to the customer
after purchase. This setting applies also to Pay with Amazon as long as Login with Amazon is enabled.

30 Chapter 4. Configuration



Amazon Pay (EU and UK) - extension for Magento 1.x, Release 3.0.20

4.3.4 Authentication Experience

Select the method the authentication will be processed. By default Pop-up is used, meaning that after pressing Pay or
Login with Amazon button, new window with Amazon login form opens, this requires the page you are placing the
buttons on to be SSL-secured though. Choosing Redirect experience your customers will be redirected to Amazon
login form in the current window after pressing Pay or Login with Amazon button. For the Redirect experience it is
required to set Allowed Return URLs in the Login with Amazon section in your Seller Central.

Warning: Be aware that Pop-up authentication experience used by default requires the page, the button is placed
on, to be in the SSL mode. This requirement is fulfilled by switching the cart page into SSL on the fly. This
may lead to the unexpected results, especially if you are using some non-default Magento extensions (eg. AJAX-
based adding to cart). It is always advised to test the extension in the staging environment prior to the production
deployment.

4.4 Email Options

4.4.1 Send order confirmation

This option allows you to select whether a confirmation email for newly placed orders shall be sent by the shop. Note
that, regardless this setting, a payment confirmation will be always sent by Amazon Payments.

Note: Order confirmation emails are not sent unless authorization is confirmed. If the emails are not sent, even you
have above option enabled, it is very likely that Amazon Payments transactions are not updated. In such a case please
make sure your shop accepts IPN notifications or polls transaction data in the cronjob.

4.4.2 Declined Payment Email Template

In this option you can select an email template which will be used for notifying customers about declined authoriza-
tions. Refer to the Email templates section to find out how to customize email templates.

4.4.3 Declined Payment Email Sender

With this option you can define the sender of the Authorization declined email notification. The sender can be selected
from the pre-defined Magento email contacts (System → Configuration → Store Email Addresses).
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4.5 Common Appearance Settings

In this section you can set size (width and height) of Amazon widgets used in the checkout process.

4.5.1 Use responsive widgets

With this option you can decide if Amazon widgets used in the checkout (address book, wallet) will adapt to the layout
by filling whole container area. This behavior allows to set widget size by defining size of its container in the external
CSS file, making Amazon checkout compatible and easy to use with responsive layouts. Disabling this option will
change the widgets to use explicit sizes defined in the next config options of this section.

4.5.2 Address widget width, Address widget height

In this option you can set size in pixels (width and height) of Amazon address book widget for disabled Use responsive
widgets option.

4.5.3 Wallet widget width, Wallet widget height

In this option you can set size in pixels (width and height) of Amazon wallet widget for disabled Use responsive
widgets option.

4.6 Alexa Delivery Notifications

Alexa delivery notifications for Amazon Pay merchants allow you to pro-actively inform your customers if their order
is on its way or has arrived. After enabling the feature, you will need to get your Public Key ID to be able to interact
with the Amazon Pay Delivery Tracker APIs. To do so, please follow the instructions given in this guide.

Once done, you will have your Private Key and Public Key ID. Please enter them into the corresponding fields. If your
version still has a Public Key field, please simply ignore it and continue.

32 Chapter 4. Configuration

https://developer.amazon.com/de/docs/amazon-pay-automatic/delivery-notifications.html#get-your-public-key-id


Amazon Pay (EU and UK) - extension for Magento 1.x, Release 3.0.20

Configure your carriers using the Carrier codes form by selecting your available carriers and assign them to the
matching one in the Amazon Pay carrier list.

Save your work and you are done. To verify, if everything is working as expected, simply mark an AmazonPay order
as shipped and add a tracking code to the shipment. The API Log should show a successfull delivery tracker request
(Status Code: 200).

4.7 Appearance Settings for Login and Pay with Amazon

These settings apply to the design (type, size and color) of the buttons, both Pay with Amazon and Login with Amazon,
when Enable Login with Amazon option is set to Yes, therefore they become irrelevant if you don’t use Login with
Amazon service, you may be interested then in Appearance Settings for standalone Pay with Amazon.
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4.8 Appearance Settings for standalone Pay with Amazon

These settings apply to the design (size and color) of the Pay with Amazon button when Enable Login with Amazon
option is set to No, therefore they become irrelevant if you use Login with Amazon service, Appearance Settings for
Login and Pay with Amazon are applied then.

4.9 Developer options

4.9.1 Allowed IPs (comma separated)

For testing or debugging purposes you can restrict access to Pay with Amazon checkout in your shop to certain IP
numbers only. Pay with Amazon button will be shown only for the visitors coming from allowed IPs. You can set
more than one allowed IP separated with commas.

4.9.2 Enable logging

The Pay with Amazon extension comes with a dedicated logging mechanism. Any exception, API call or IPN notifi-
cation will be saved to the var/log/amazonpayments folder in your Magento installation. For your convenience logs
are also accessible via creativestyle → Login and Pay with Amazon → Log preview in Magento admin. Refer to the
Event logs section to get more details concerning the logging feature.

Warning: This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) instead.
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CHAPTER 5

Design customization

5.1 Frontend templates

If you are using a custom design theme and would like to adjust the appearance of Login and Pay with Amazon
templates, please complete the following steps (all paths are relative to the Magento root folder):

Warning: Never edit the default template or skin files directly as they can be (and surely will be) overwritten
when upgrading this extension to a newer version. Edit their copies only as described below.

• Create folders:

app/design/frontend/YOURPACKAGE/YOURTHEME/template/creativestyle/
amazonpayments skin/frontend/YOURPACKAGE/YOURTHEME/creativestyle/css skin/
frontend/YOURPACKAGE/YOURTHEME/creativestyle/images

On Unix-like (Linux, BSD) servers you can achieve this by running following commands, please remember to
replace YOURPACKAGE and YOURTHEME with the real names of your theme:

$ cd /path/to/your/Magento
$ mkdir -p app/design/frontend/YOURPACKAGE/YOURTHEME/template/
→˓creativestyle/amazonpayments
$ mkdir -p skin/frontend/YOURPACKAGE/YOURTHEME/creativestyle/css
$ mkdir -p skin/frontend/YOURPACKAGE/YOURTHEME/creativestyle/images

• Clone the following files:

app/design/frontend/base/default/layout/amazonpayments.xml app/design/
frontend/base/default/template/creativestyle/amazonpayments/* skin/
frontend/base/default/creativestyle/css/amazonpayments.css skin/frontend/
base/default/creativestyle/images/*

On Unix-like (Linux, BSD) servers you can achieve this by running following commands, please remember to
replace YOURPACKAGE and YOURTHEME with the real names of your theme:
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$ cd /path/to/your/Magento
$ cp app/design/frontend/base/default/layout/amazonpayments.xml app/
→˓design/frontend/YOURPACKAGE/YOURTHEME/layout/amazonpayments.xml
$ cp app/design/frontend/base/default/template/creativestyle/
→˓amazonpayments/* app/design/frontend/YOURPACKAGE/YOURTHEME/template/
→˓creativestyle/amazonpayments/*
$ cp skin/frontend/base/default/creativestyle/css/amazonpayments.css skin/
→˓frontend/YOURPACKAGE/YOURTHEME/creativestyle/css/amazonpayments.css
$ cp skin/frontend/base/default/creativestyle/images/* skin/frontend/
→˓YOURPACKAGE/YOURTHEME/creativestyle/images/*

After cloning the above files to your theme folders, you can adjust the design by editing the appropriate files (HTML
templates, CSS stylesheets and layout file). You can enable Template Path Hints to find out the names of the template
files used by the extension in particular steps of the checkout process (in Magento admin, within selected store view
scope: System → Configuration → Developer → Debug).

Note: Please note that the ID attributes of all HTML tags must be preserved, otherwise changes to the corresponding
JS scripts must be applied (do not try to change it unless you know what are you doing).

Basic appearance of rendered Amazon widgets (button color and size of all widgets) can be set in the Pay with
Amazon extension settings (System → Configuration → Amazon Payments), see Common Appearance Settings, Ap-
pearance Settings for Login and Pay with Amazon and Appearance Settings for standalone Pay with Amazon for more
details.

5.2 Amazon Payments logo

If you want to place the Amazon Payments logo in your shop to let your customers know you’re using payment services
provided by Amazon Payments refer to the following guidelines:
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• logos:

– UK: https://payments.amazon.co.uk/merchant/tools#marks

– DE: https://payments.amazon.de/merchant/tools#marks

• button placement:

– UK: https://payments.amazon.co.uk/merchant/tools#guidelines

– DE: https://payments.amazon.de/merchant/tools#guidelines

To complement the logos you should mention Amazon Payments under your listing of supported payment methods.

5.3 Email templates

Magento provides an easy-to-use mechanism for adjusting email templates’ appearance and content. If you want to
customize the emails that are sent by the extension, go to System → Transactional Emails in your Magento admin and
follow the instructions:

On the Transactional Emails list press Add New Template button and the form will appear. In the Load default template
section choose Amazon authorization declined from the Template dropdown, change Locale, if needed, which will be
used for the loaded template pattern (Pay with Amazon extension provides 3 locales: German, English UK and
English US, for any other locale selected, the english (US) template will be loaded) and press Load Template button.
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Fields in Template Information section will be filled out with the data taken from the default email template. Please
fill in the missing name of your modified email template in the Template Name input, adjust Template Content and
Template Styles to your needs and save your work by pressing Save Template button. The new template shall appear
on the Transactional Emails list.

The newly created email template can be used now, you can switch to it in the extension settings, see: Declined
Payment Email Template.

Warning: This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) instead.
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CHAPTER 6

Login with Amazon

Login with Amazon allows users to login to your shop using their Amazon user name and password. All available
data needed for creating an account or placing an order in your Magento shop (including name, email address, and zip
code) are fetched automatically from customer’s Amazon account.

6.1 Requirements

Login with Amazon service requires you to have a valid Login and Pay with Amazon account (refer to the Amazon
Pay and Login with Amazon account setup if you don’t have one yet), registered application for Login with Amazon
service (refer to the Registering application for Login with Amazon service if you don’t have one yet) and Magento
store with a valid SSL certificate installed and properly configured in your shop. By “installed and properly configured
SSL certificate” it is meant that your webserver is configured to serve pages via HTTPS protocol, Base URL config
option is set to the HTTPS-based URL and in Web → Secure section of Magento settings.

6.2 Login with Amazon button

The Login with Amazon button appears in several places in the shop:

• on the customer login page,

• on the customer registration page.
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You can also place the Login with Amazon button in any place you like by including following statement in the template
file:

<?php echo Mage::helper('amazonpayments')->getLoginWithAmazonButton(); ?>

Pressing the Login with Amazon button launches the Amazon authentication window, where the customer is asked for
his Amazon account e-mail address and password.
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After a successful login the customer is redirected to the user area in your shop.

Note: When the customer uses the Login with Amazon for the first time in your shop and account with the same e-
mail address already exists in your shop, he will be asked to enter his shop password to match both shop and Amazon
accounts. Moreover, if you require additional data from your customers which cannot be provided by Amazon (like
date of birth or gender), the customer will be asked for those data in a dedicated form, that appears after the first use
of Login with Amazon button.

Warning: This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) instead.
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CHAPTER 7

Order & payment workflow

The Login and Pay with Amazon extension follows the standard Magento order and payment workflow, and thus
processing Pay with Amazon payments doesn’t differ significantly from other payment methods available in Magento,
making it easy to handle. The most important difference, comparing to the standard Magento orders, is delayed access
to the billing address, which is backfilled later in the synchronization process after the successful authorization.

All Amazon payment objects (OrderReference, Authorize, Capture and Refund) are reflected in corresponding pay-
ment transactions in Magento, which are connected with appropriate document entities provided by the Magento,
(invoices for captures, credit memos for refunds).

7.1 Pay with Amazon button

The Pay with Amazon button appears in several places in the shop:

• on the shopping cart page,

• in the 1st step of the default One Page Checkout,

• in the sidebar cart widget.

43



Amazon Pay (EU and UK) - extension for Magento 1.x, Release 3.0.20

You can also place the Pay with Amazon button in any place you like by including following statement in the template
file:

<?php echo Mage::helper('amazonpayments')->getPayWithAmazonButton(); ?>

Pressing the Pay with Amazon button launches the Amazon Payments authentication window, where the customer is
asked for his Amazon account e-mail address and password.
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After a successful login the customer is redirected to the Amazon checkout page in your shop.

7.2 Placing an order

The Pay with Amazon checkout form consists of 4 steps arranged within a single page (unlike Magento default
checkout, which uses accordion for showing and hiding particular steps of the checkout). These steps are: shipping
address (handled by Amazon’s address book widget), payment method (handled by Amazon’s wallet widget), shipping
method and order review (handled by default Magento checkout templates). All fields in the form (shipping address,
payment method and shipping method) are pre-filled, which means that in very basic scenario customer can finish the
checkout with just one click. Unfortunately, pre-filling doesn’t apply to the terms and conditions checkbox (if used at
all) and can raise the number of required clicks, which, however, doesn’t affect the easiness and user-friendliness of
the Pay with Amazon payment method.
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Note: The value selected in each checkout step is saved in a separate AJAX call. When the checkout form shows up
for the first time, depending on the internet connection speed and the web-server’s response time, it may take up to
few seconds until Place order button gets active and can be clicked by the customer.

After selecting the desired shipping address, payment method, shipping method and pressing Place order button
(preceded by accepting terms and conditions if needed), the customer is redirected to the success page. Pay with
Amazon uses the default Magento success page, which means there’s no need to add any tracking scripts or additional
page layout elements that you use in default Magento checkout and want also use in Amazon checkout, all features

46 Chapter 7. Order & payment workflow



Amazon Pay (EU and UK) - extension for Magento 1.x, Release 3.0.20

implemented additionally on the Magento success page shall also appear on Amazon checkout success page.

The created order will be transferred to Amazon and will appear in your Magento admin in Pending (by default) or
Processing (if you are using synchronous authorization) state.

Note: You may notice in the Magento admin that the billing address may be incorrect at this point (as mentioned in
the introduction to this chapter). That’s true if the billing differs from the shipping data. The only available payment
object at the time of placing order is the OrderReference, which, unfortunately, doesn’t provide billing data and thus
shipping address must be used to meet Magento requirements concerning order data. The billing address will be
updated as soon as authorization is confirmed by Amazon Payments. Keep also in mind that the billing address is
available only for the sellers that provided a valid VAT number in Amazon Seller Central.

7.3 Multicurrency support

Amazon Pay extension supports multicurrency payments on the website level. Website is the top level organizational
unit in Magento, it may share customer accounts, shipping and payment methods. To offer multicurrency support that
is provided by Amazon Pay service in your Magento shop, you have to create a separate website for each currency you
plan to offer in your shop, with the selected currency set as a base currency in Magento settings.
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By default the base currency is set globally in Magento, to make it available on the website level, please go to System
→ Configuration → Catalog → Catalog → Price → Catalog Price Scope and set its value to Website.

Next go to System → Configuration → General → Currency Setup → Currency Options → Base Currency and
set its value to the selected currency for each of the websites you created previously to offer multicurrency support
for your customers. The website configuration scope can be changed by selecting appropriate entry in the Current
Configuration Scope dropdown list in the top right corner of the configuration page.
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Note: Please note, that multicurrency support in the extension doesn’t use Display Currency setting, which may be
set on the store view level. Display currency is used just for the storefront presentation purposes and doesn’t play any
role in further order post-processing, because all transactions are processed using base currency. Such a behavior is
implemented in Magento core classes and Amazon Pay extension do not break this rule.

7.4 Payment authorization

An authorization can be requested after the order data is successfully transferred to Amazon. Depending on the
value you’ve selected for Payment Action option it can be processed in several ways. For Authorize and Authorize &
capture actions it will be requested automatically as soon as order is placed in your shop and successfully transferred
to Amazon. The requested authorization will be therefore either confirmed or declined by Amazon either via IPN
message or via data polling, see Synchronizing order data to get more details. The order, for which a payment
authorization has been confirmed changes its state to Processing, an order email confirmation is sent to the customer
(if not disabled in the extension settings, see Send order confirmation) and you can start the fulfilment process.

Warning: Never dispatch ordered items before the authorization is confirmed. Only the confirmed authorization
guarantees that you will be able to capture the order amount (if you capture within 7 days).

7.4.1 Manual authorization

In case you ship ordered items after 30 days or more you have to select Manual authorization as a payment action. It
will stop Magento from requesting an authorization automatically and let you make an authorization request manually
from the Magento admin at any suitable time. To manually invoke an authorization, login to the Magento admin, open
the order you want authorize payment for and click the Authorize payment button placed in the top buttons rows.
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Next post-request processing (authorization confirmation or decline) is processed in the same way as in automatic
authorization (through polling or IPN).

7.4.2 Declined authorizations

If the authorization is declined by Amazon due to problem with the payment method selected, your customer will
be informed about this case via e-mail and requested to visit the Amazon Payments web site. The customer can on
this page update the payment method by following the instructions on the web page. The e-mail sent to the customer
can be adjusted according to the Email templates section. After the successful payment method update, Amazon will
notify Magento about the new authorization status and payment will get back on the track (via polling or IPN).

In case the authorization has been declined due to any other reason then problems with the selected payment method,
the notification email will be sent to shop administrator and appropriate action must be undertaken according to the
Amazon Payments Integration Guide.

7.5 Capturing the payment amount

After a successful authorization, you can capture funds against the authorization. The capture, similar to the autho-
rization, can be requested in two modes: manual and automatic. By default you should capture the order amount at
the moment you ship the ordered items by creating an invoice. You are only allowed to enable automatic capture
if you sell digital goods or you ship items the same day they are ordered. Moreover you have to be white-listed by
Amazon Payments. Contact Amazon Payments if you want to use this option.

Payment Action option in the extension settings allows to switch between manual and automatic capture mode. For
Manual authorization & Authorization actions the capture is triggerd by creating manually an invoice for the order in
the Magento admin. For Authorize & capture action, the capture is requested automatically as soon as authorization is
confirmed by Amazon Payments.

7.5.1 Manual capture

To capture the order amount, you must create an invoice first. To create an invoice, login to the Magento admin, open
the order for which you want to capture the amount and click the Invoice button located in the top buttons rows. Please
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make sure that the order you want to process has been successfully authorized, which basically means that it is in
Processing state.

After clicking the Invoice button, a new invoice form will appear with most of the crucial data (like products quantity)
already filled in. You can adjust some invoice fields if needed. At this point you can create a shipment as well, by
checking Create Shipment checkbox and adding a tracking number if needed. Before submitting the form, please
make absolutely sure that Amount selectbox is set to Capture online and press Submit Invoice button. A new invoice
and a new shipment (if checked Create Shipment checkbox) will be created for the order and the capture request is
sent to Amazon Payments.

Warning: To collect the funds that were authorized, you must capture the amount within 30 days of a successful
authorization (two days in Sandbox mode). We strongly recommend that you capture funds within seven days
of authorization to reduce the likelihood of declines (within 7 days the a successful captures is guaranteed). In
case your fulfilment process exceeds 30 days, consider using the Manual authorization as payment action in the
configuration and authorize the payment later in any suitable time (typically in the week before the shipping) before
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the shipping.

Note: Partial captures are not supported by the extension at this moment.

The capture status, similar to authorizations, will be updated either via IPN message or via data polling, see Synchro-
nizing order data for more details.

7.5.2 Automatic capture

In this mode the capture is requested automatically after the successful authorization. Also the invoice that covers all
ordered items is created automatically. Post-request processing (capture status synchronization) is carried the same
way as in capture invoked manually from Magento backend.

7.6 Refunding order items

The order, which payment has been captured for, can be refunded either fully or partially. Refunds are made against
the invoices and thus having a paid invoice assigned to the order is a necessary condition that has to be met to refund
any order item. Refunds in Magento are recorded as credit memos, so for requesting a refund with Amazon Payments
you should create a credit memo first. To create a credit memo login to the Magento admin, open the order you want
refund, click Invoices tab on the right, select an invoice you want to refund and click on it.

A preview of the selected invoice will appear. Make sure that you are on the single invoice preview page and click the
Credit Memo button.
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A new credit memo form will appear with most of the crucial data (like products quantity to be refunded) already filled
in. If you want to refund the invoice partially (i.e. only a part of the invoiced items) adjust the product quantities to
be refunded (set 0 for items that shall not be refunded) and click Update Qty’s button to update refund totals. You can
also set the refunded items back to stock by checking Return to Stock checkbox. Next choose if you want to refund
shipping costs or apply any refunds adjustment and fill in the appropriate fields. Next before submitting the credit
memo form, double check that you have Refund button available and click it. A credit memo will be created and a
refund will be requested with Amazon Payments. Its status will be updated either via IPN or data polling, depending
on the update method selected in the extension settings.
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Warning: For the successful refund (recorded in Magento and requested (!) with Amazon Payments) always use
Refund button available on the new credit memo form invoked from the single invoice preview page. If you click
Credit Memo button directly on the order page you will be redirected to the new credit memo form with Refund
offline button only, which admittedly will record credit memo in Magento, but surely won’t call refund request at
Amazon Payments gateway. If in any case you will get a credit memo with Refund offline button only then surely
something had to go wrong and you should stop the refund process immediately and start it from the beginning
following the above guideline.

7.7 Cancelling an order

For a variety of reasons it sometimes becomes necessary to cancel an order. To cancel an order and notify Amazon
about the payment cancellation:

• Please make sure the amount of the order you want to cancel hasn’t been captured yet,

• Go to Sales → Orders and select the order that you would like to cancel by clicking the Edit button on its
respective row,

• Click Cancel in order page to remove this order.
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7.8 Synchronizing order data

Warning: This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) instead.
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CHAPTER 8

Testing your integration

After a successful configuration, you should test your installation. Only after successfully testing in the Sandbox mode
you should switch to the live environment and make the button visible for all your sellers.

These tests should cover the different workflow that you encounter while processing orders. Both include the standard
process like receiving an order, invoicing, shipment and alternative processes like canceling orders and refunding
orders. Verify that all objects in your Magento admin are in the expected status and you correctly received all order
information including the shipping address, contact details and the billing address (if applicable).

Next you should test also declines. You can use the Sandbox Toolbox to simulate soft and hard declines of authoriza-
tions. After your testing verify the log files to make sure no exceptions have occurred.

To receive the complete testing scenarios contact Amazon Payments.

8.1 How to create Sandbox test account

To use the sandbox environment, you need to create specific test accounts for the sandbox environment.

• Login into Seller Central.

• Choose the menu Integration → Test accounts.

• Click on Create a new test account.
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• Fill in the form using a valid email address. The account can be used immediately after the account creation.

• Add other delivery addresses to the test account (optional).

Warning: This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) instead.
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CHAPTER 9

Frequently Asked Questions

9.1 Installation

I have successfully installed Login and Pay with Amazon extension, but when I try to go to the configuration
page System → Configuration → Amazon Payments I am getting: 404 Not Found error.

It’s a Magento bug, the ACL list is not reloaded after the new extension is installed. To solve this issue please logout
from the Magento admin and next login again.

It is stated that the extension is compatible with Magento 1.5, but when I try to place an order I am getting an
exception: Invalid method Mage_Sales_Model_Order_Payment::lookupTransaction().

Magento 1.5 doesn’t provide public wrapper for _lookupTransaction() method of order payment model, which is
commonly used by Pay with Amazon extension. To fix this issue we have prepared a compatibility pack that rewrites
current sales/order_payment model. You can install it via Magento Connect, to do so go to System → Magento Connect
→ Magento Connect Manager, enter your admin credentials to get logged in, in the Install New Extensions section
enter http://connect20.creativetest.de/Creativestyle_AmazonPaymentsCompatibilityPack key and click Install button.

Warning: Keep in mind that if any other 3rd party extension rewrites the sales/order_payment model as well,
installing Magento 1.5 Compatibility Pack may lead to a rewrite conflict resulting in misfunction of one or more
extensions. It is always advised to test it on a staging system prior to deploy to the production.

9.2 Frontend

How can I disable Pay with Amazon for certain products?

There are few extensions available for disabling payment methods on-the-fly based on the desired conditions. We
recommend to install and use Rico Neitzel’s PaymentFilter for Products and Customer Groups, which Pay with
Amazon has been successfully tested against.
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Pay with Amazon button doesn’t show up in the cart after the extension is installed and set up.

Lack of Pay with Amazon button in the cart is usually caused by one of the following reasons:

• incorrect Merchant ID set (double check if you don’t have any whitespaces in your Merchant ID),

• incorrect Marketplace set,

• your Amazon seller account is either blocked or not activated (you can check status of your account in Amazon
Seller Central).

You can check validity of the provided Amazon Payments credentials using Validate Amazon Payments account button
available in the extension settings. In case you are sure you have Merchant ID and Marketplace correctly set, check if
any of the following extensions is installed and enabled in your shop and follow the instructions:

• Mxperts_NoRegion

• FME_Ajaxaddtocart

Those extensions replace default checkout.cart block with own ones. The replaced block doesn’t include checkout
buttons defined previously. To bring the Pay with Amazon button back, find appropriate layout file:

• noregion.xml for Mxperts_NoRegion extension,

• ajaxaddtocart.xml for FME_Ajaxaddtocart extension

in your theme folder (or in the default theme folder) and modify checkout.cart.methods and / or check-
out.cart.top_methods blocks by adding following code:

<block name="checkout.cart.methods" as="methods" type="core/text_list"
→˓translate="label">

(...)
<block type="amazonpayments/pay_button" name="checkout.cart.methods.

→˓amazonpayments_pay.bottom" before="-">
<action method="setIdSuffix"><value>div</value></action>
<action method="setEnableOr"><value>1</value></action>

</block>
</block>
(...)
<block name="checkout.cart.top_methods" as="top_methods" type="core/text_list
→˓" translate="label">

(...)
<block type="amazonpayments/pay_button" name="checkout.cart.methods.

→˓amazonpayments_pay.top" before="-">
<action method="setIdSuffix"><value>top</value></action>
<action method="setEnableOr"><value>1</value></action>

</block>
</block>

After upgrade to 3.x, when the buyer clicks Amazon Pay button in the cart, he is redirected to the customer
dashboard instead of the checkout.

1. Please make sure that your webserver serves the most recent version of the
js/creativestyle/amazonpayments.min.js file. Some webservers (as well as CDNs) are caching static as-
sets, so it may happen that your shop serves an outdated version of the frontend JS application.

2. If you are using custom layout or template files for Amazon Pay, make sure that your customizations are com-
pliant with the recent changes in the extension. The easiest way to check is your customization is the case is to
delete following files as after refreshing Magento cache, see if this resolves your issue:
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• app/design/frontend/CUSTOMPACKAGE/CUSTOMTHEME/layout/amazonpayments.xml

• app/design/frontend/CUSTOMPACKAGE/CUSTOMTHEME/template/creativestyle/amazonpayments/js.phtml

• app/design/frontend/CUSTOMPACKAGE/CUSTOMTHEME/template/creativestyle/amazonpayments/login/redirect.phtml

Warning: This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) instead.
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CHAPTER 10

Troubleshooting

Before taking any action, please refer to the Frequently Asked Questions section, where many common issues have
been already explained and solved.

10.1 Event logs

The Pay with Amazon extension provides a convenient logging system. It is disabled by default, but you can enable
it in the extension settings, refer to the Enable logging section for more details.

10.1.1 Log files location

The Logger saves details concerning all exceptions, all API calls and all incoming IPN notifications that occurred
within the Pay with Amazon extension scope. Logs are stored in CSV files in the following locations:

• exceptions logs:

var/log/amazonpayments/apa_exception.log

• API calls logs:

var/log/amazonpayments/apa_api.log

• IPN notifications logs:

var/log/amazonpayments/apa_ipn.log

10.1.2 Logs accessing

In case you encounter any issues and Frequently Asked Questions section didn’t help, you should review your logs in
the next step. Logs can be accessed in two ways:

• Using creativestyle → Pay with Amazon → Log preview feature, where all logs are displayed on a convenient
list with basic filtering options.

63



Amazon Pay (EU and UK) - extension for Magento 1.x, Release 3.0.20

• By directly accessing (using FTP, SFTP or SSH, depending on your server configuration) the above files on your
server. After the download you can open them with any CSV-capable application. The current log files can be
also downloaded by pressing Download as CSV button on the logs list creativestyle → Pay with Amazon → Log
preview in the Magento admin.

10.1.3 Logs rotating

All log files are rotated as soon as they exceed the size of 8 Megabytes, the old log file is renamed then to var/log/
amazonpayments/apa_*.log.timestamp and a new empty file is created for storing the new log entries. The
old log files are still accessible by direct access (FTP, SFTP or SSH) to var/log/amazonpayments folder on the
server.

10.2 Contact support

If you haven’t found a solution for your problem and need to contact us directly, please submit a support ticket on
http://creativeticket.de site.

Warning: This extension is not maintained anymore. Please use Amazon Pay (Checkout v2) instead.
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CHAPTER 11

Changelog

11.1 Version 3.0.20

11.1.1 Fixes

• Fix array to string conversion error in IPN logger

11.2 Version 3.0.18

11.2.1 Fixes

• Fix payment URLs in the declined payment emails

11.3 Version 3.0.16

11.3.1 Changes and improvements

• Make Amazon Pay overview URL dynamic in the declined payment email

11.3.2 Fixes

• Remove apostrophe from Alexa carrier codes CSV
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11.4 Version 3.0.14

11.4.1 Improvements & changes

• Implemented Alexa Delivery Notifications

11.4.2 Fixes

• Fixed race condition issue for the IPN notifications overlapping with the authorization process

• Fixed bugs for ERP and manual authorization modes

• Stop closing order reference on partial capture

11.5 Version 3.0.12

11.5.1 Fixes

• Fixed Firefox redirect experience issue

• Fixed misbehaviour of the button in the mini cart widget on the product details page

11.6 Version 3.0.10

11.6.1 Fixes

• Fixed the empty-cart issue brought by SUPEE-11155 security patch and Magento CE 1.9.4.2, EE 1.14.4.2

11.7 Version 3.0.8

11.7.1 Improvements & changes

• Implemented JS versioning

• Added support for newsletter subscription in the checkout

11.8 Version 3.0.6

11.8.1 Fixes

• Fixed redirect URL issues for the redirect authentication experience
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11.9 Version 3.0.2

11.9.1 Improvements & changes

• Implemented Amazon Pay Strong Customer Authentication (PSD2 compliance)

11.10 Version 2.0.28

11.10.1 Improvements & changes

• Improved button tooltip handling on mobile devices

• Explicitly set environment params for login JS application

• Re-structure settings page

11.10.2 Fixes

• Fixed reference to the closed cURL resource in Amazon Pay SDK lib

• Add support for form key validation in One Page Checkout

11.11 Version 2.0.26

11.11.1 Changes

• Stop keeping order reference ID and access token in the session data

• Force transaction data re-fetch on incoming IPN notification

• Re-implement Amazon Pay API requests logging

11.11.2 Fixes

• Add shipping rates recollecting after saving shipping address (fixes shipping costs issue)

11.12 Version 2.0.24

11.12.1 Fixes

• Fixed shipping address processing during the checkout
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11.13 Version 2.0.22

11.13.1 Changes

• Revert APA deprecation (Make Client ID config option optional)

11.14 Version 2.0.20

11.14.1 Changes

• Make Client ID config option mandatory (APA deprecation)

11.14.2 Fixes

• Fixed non-working Amazon Pay button on the product page when Login is disabled

11.15 Version 2.0.18

11.15.1 Changes

• Splitted Eurozone region

11.15.2 Changes

• Wrap execution of external JS on checkout page in try-catch block

11.15.3 Fixes

• Fixed automatic invoice creation for auth & capture payment action

• Fixed typos in config options paths

11.16 Version 2.0.16.1

11.16.1 Fixes

• Fixed saving access key and secret key options issue

11.17 Version 2.0.16

11.17.1 Major Highlights

• Implemented support for One Page Checkout
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11.17.2 Improvements

• Added support for SetOrderAttributes API call

11.17.3 Changes

• Updated Amazon Payments SDK library

11.18 Version 2.0.14

11.18.1 Improvements

• Enabled support for multi currency globally

11.18.2 Fixes

• Skip declined payment email sending for synchronous authorizations

• Fix JS to dispose security warning in Magento malware scanner

11.19 Version 2.0.12

11.19.1 Fixes

• Added missing translations for custom order statuses settings (#131)

• Re-authorization after InvalidPaymentMethod follows payment action settings (#133)

• Added order reference cancellation for asynchronous TransactionTimedOut authorization (#134)

11.20 Version 2.0.10

11.20.1 Improvements

• Added configurable order statuses for declined authorizations (#129)

• Implemented basic support for custom fields in the checkout

11.20.2 Fixes

• Fixed invoice status update on successful capture notification (#128)
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11.21 Version 2.0.8

11.21.1 Improvements

• Added configurable multi currency

11.21.2 Fixes

• Fixed missing Refund online button for invoices created automatically for CaptureNow options (#127)

• Fixed TransactionTimedOut and AmazonRejected auth declines handling in synchronous mode

11.22 Version 2.0.6

11.22.1 Improvements

• Added support for soft descriptor in authorization call (#115)

• Added Amazon Pay button tooltip (#121)

• Implemented automatic order reference closing on successful capture (#126)

• Ignore authorization IPNs for synchronous mode (#120)

11.22.2 Fixes

• Fixed double invoice bug for manual capture (#122)

11.23 Version 2.0.4

11.23.1 Improvements

• Added Amazon Pay button on product view page

11.23.2 Fixes

• Fixed non-working Login for new customers

11.24 Version 2.0.2

11.24.1 Fixes

• Fix issues with wallet re-render for declined auth
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11.25 Version 2.0.0

11.25.1 Major Highlights

• Implemented omni-chronous authorization

11.25.2 Changes

• Refactored order post-processing

• Changed IPN endpoint URL

• Changed frontend layout and templates (no backward compatibility)

• Simplified frontend JS application

11.26 Version 1.8.6

11.26.1 Improvements

• Added coupon code handling in Amazon checkout review

• Added possibility to disconnect customer account from Amazon account

11.26.2 Changes

• Removed password form for account matching when customer is logged-in

• Updated Amazon Pay logos in Magento admin

11.26.3 Fixes

• Fixed PHP versions in Magento Connect package.xml file

11.27 Version 1.8.4

11.27.1 Improvements

• Support for France, Italy and Spain

• Support for PHP 7

• Configurable store name in API calls

11.27.2 Changes

• Amazon Payments re-branding
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11.27.3 Fixes

• Fixed legacy payment method bug when trying to list all payment methods

• Fixed missing original_price and base_original_price item’s attributes after order is placed

• Added missing return statement to the IPN controller

11.28 Version 1.8.2

11.28.1 Major Highlights

• Implemented Quick Configuration (Simple Path)

11.28.2 Improvements

• Added verbosity to error messages on frontend in sandbox mode

• Set payment method as soon as Amazon checkout is started

11.28.3 Fixes

• Fixed call to member function on null $quote variable in payment method model

11.29 Version 1.7.8

11.29.1 Improvements

• Implemented simplified partial capture

11.29.2 Changes

• Updated Amazon Payments SDK library

11.29.3 Fixes

• Added missing declined payment email templates for FR, IT and ES

• Fixed several issues for hard declined authorizations in synchronous mode

11.30 Version 1.7.6

11.30.1 Improvements

• Added support for custom SSL CA bundle file

• Implemented automatic authentication experience
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• Disable Pay with Amazon availability for zero-total orders

• Retrieving billing address during the checkout

• Added exception handling for missing amazon_user_id attribute

11.30.2 Fixes

• Added support for SUPEE-6285 patch

• Added support for SUPEE-6788 patch

• Fixed calls to deprecated iconv functions in SDK library

• Fixed display errors for Magento RWD theme

11.31 Version 1.7.4.1

11.31.1 Fixes

• Fixed incorrect billing address issue for Auth & capture payment action

11.32 Version 1.7.4

11.32.1 Improvements

• Added missing payment cancellation functions

• Added Login with Amazon button on the customer registration page

• Added retrieving shipping address during the checkout

• Disabled Amazon button for virtual orders when Login is disabled

11.32.2 Fixes

• Fixed issue with placing virtual orders in sandbox mode

• Fixed closing order reference on completed capture

11.33 Version 1.7.2

11.33.1 Major Highlights

• Implemented multilanguage feature for Login with Amazon
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11.33.2 Improvements

• Implemented re-authorization after the first authorization expires

• Putting order on hold for some kinds of closed authorization

• Added reason code of the transaction status directly to the order comments

• Added store name to SetOrderReferenceDetails call

11.33.3 Changes

• Updated Amazon Payments SDK library to 1.0.14

11.33.4 Fixes

• Fixed Firefox redirect experience issue

• Fixed issues in the splitting full customer name helper function

11.34 Version 1.6.4

11.34.1 Major Highlights

• Implemented redirect authentication experience

11.34.2 Improvements

• Added links to the seller credentials in Amazon Seller Central on extension settings page

• Added Amazon Seller Central order link on order preview page in Magento admin

• Added invoice cancellation on declined capture

• Modified way of identifying Place order button in the checkout based on button ID instead of container class
name

11.34.3 Fixes

• Removed button tooltip for mobile devices

• Fixed missing re-authorization on declined authorization in Auth & capture payment mode

11.35 Version 1.6.2

11.35.1 Fixes

• Fixed bugs in the refactored payment method model

• Fixed IPN processing bugs in v.1.6.0

• Fixed 404 error when customer press Cancel on Amazon login form
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11.36 Version 1.6.0

11.36.1 Major Highlights

• Implemented synchronous authorization

11.36.2 Improvements

• Made initial order status configurable

• Refactored payment method model

11.37 Version 1.3.4

11.37.1 Improvements

• Added gift messages support

• Improved customer address handling for Germany and Austria (extracting company name from the address)

11.37.2 Changes

• Switched IPN endpoint URL to non-secure mode if sandbox is enabled

11.37.3 Fixes

• Fixed missing original_price and base_original_price item’s attributes after order is placed

• Fixed state of Place order button which was enabled even the payment method is not selected

• Fixed state of Place order button which was disabled for virtual orders

11.38 Version 1.3.2

11.38.1 Major Highlights

• Implemented asynchronous way of loading Amazon Payments JS libraries

11.38.2 Improvements

• Added cURL error handling for Login with Amazon API calls
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11.38.3 Changes

• Using deminified JS when sandbox mode is on for easier debugging

• Modified Pay with Amazon button tooltip text for virtual orders

• Refactored Amazon Payments SDK library to fix autoloader issues

11.38.4 Fixes

• Fixed wrong shipping cost when additional fees (acting as additional items in total section) are applied

• Fixed issue with Merge JS option enabled

• Closing OrderReference transaction after succesful capture

11.39 Version 1.2.6

11.39.1 Major Highlights

• Implemented responsive Amazon Payments widgets in the checkout

11.39.2 Fixes

• Fixed error when accessing extension settings page on Magento lower than 1.7.0.1

• Fixed issues with Magento compiler

11.40 Version 1.2.4

11.40.1 Fixes

• Fixed Pay with Amazon button appearing twice when Login with Amazon feature is enabled

11.41 Version 1.2.2

11.41.1 Major Highlights

• Added Login with Amazon service

11.41.2 Improvements

• Added helper methods for generating Pay or Login with Amazon buttons
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11.41.3 Changes

• Changed frontend template files structure

• Changed Pay with Amazon button in the 1st step of OPC to Login with Amazon

11.41.4 Fixes

• Clean orderReferenceId session data after successful order

• Fixed issue with permanently disabled Place order button when there is more than one layer with buttons-set
class used

• Fixed using of invalid Amazon account credentials when cancelling an order in non-default store of multi-store
installations
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